Copyright and Trademarks

© 2015 (software, help system, and documentation) by Mettler-Toledo AutoChem, Inc. All rights reserved.

Neither this document nor the software described herein may be reproduced, transmitted, or disclosed to third parties, in whole or in part, in any form or by any manner, electronic or mechanical, without the express written consent of METTLER TOLEDO except to the extent provided for by specific agreements. METTLER TOLEDO reserves the right to make improvements in this document and the software it describes at any time, without notice or obligation.

iC FBRM™, FBRM®, PVM®, ParticleTrack™, ParticleView™, iC PVM™, iControl™, and iC IR™ are trademarks or registered trademarks of METTLER TOLEDO.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Acrobat® is a registered trademark of Adobe Systems, Inc. All other brand and product names are trademarks or registered trademarks of their respective owners.

12102015
Contents

1 System Requirements 4
   1.1 Minimum Requirements 4
   1.2 Recommendations for Peak Performance 4
   1.3 Operating System Support 4

2 Preliminary Setup 5
   2.1 Configure PC Power Settings 5
   2.2 Disable User Account Control Notifications 5

3 Installing iC FBRM 4.4 Software 7
   3.1 Necessary User Rights 7
   3.2 Starting iC FBRM Installation 7
   3.3 Plug the ParticleTrack Instrument into the Computer 10
   3.4 Start iC FBRM Software 10
   3.5 Scanning for Instrument 10

4 Checking for Updates 11
   4.1 Applying an iC FBRM 4.4 Service Pack 11
   4.2 Accessing the Service Pack Installers 11

5 iC Licensing 12
   5.1 Activating a Single-User License 12
      5.1.1 Activate Later—Continue Under a 30-Day Trial License 12
      5.1.2 Activate Now—Using the License Manager 12
   5.2 Obtaining an Activation Code from the MT Website 13
   5.3 Setting Up a New User Account 16
   5.4 Activating an iCare Subscription 16
   5.5 Installing a Site License 18

6 Sharing Data between iC/iControl Applications 19
   6.1 Before You Begin 19
   6.2 Connecting iC/iControl Applications 19
   6.3 Configuring the Windows Firewall 22
   6.4 Turning Off TCP/IPv6 Protocol 24

7 Appendices 25
   7.1 Installing iC FBRM Office via Scripting 25
   7.2 Deployment Packages and Dependencies 25
1 System Requirements

Below are the minimum computer requirements to run iC software plus the recommended specifications for peak performance. Since computer specifications can change, please refer to the “Computer Specifications Guide” on the METTLER TOLEDO AutoChem website (link to guide) for the latest information on the laptop available for shipment with new instruments.

1.1 Minimum Requirements

Each version is tested on a machine meeting these specifications to ensure the software will install and run correctly, but this does not guarantee reasonable performance, particularly when running longer experiments that collect more data. Higher performance processors are recommended to provide the best user experience (see Section 1.2).

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>One iC / iControl Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel® Core 2 Duo 2.2 GHz or better</td>
</tr>
<tr>
<td>Memory</td>
<td>2 GB</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>SATA 5400 rpm</td>
</tr>
<tr>
<td>Graphics</td>
<td>SXGA 1280 x 1024 with 3D hardware acceleration</td>
</tr>
</tbody>
</table>

1.2 Recommendations for Peak Performance

The specifications for laptop computers that we currently ship with new instruments are included below. This setup has been tested with several instruments connected at one time and performs well. This laptop or a similar high end model is a good choice for almost any application using iC software.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Shipped (Dell 6520)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel® Core i7-2720QM, 2.20 GHz, 6 MB Cache</td>
</tr>
<tr>
<td>Memory</td>
<td>4.0 GB DDR3 SDRAM at 1333 MHz</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>128 GB Solid State</td>
</tr>
<tr>
<td>Graphics</td>
<td>15.6-inch wide screen XGA display, 8x DVD+/-RW</td>
</tr>
</tbody>
</table>

Note: It is important to note that processor type is often more important the the CPU speed when considering performance. For example, the i7 2.2 GHz processor in the shipped laptop above performs considerably better than the 2.3 GHz i5 processor.

1.3 Operating System Support

iC FBRM 4.4 supports the 32-bit and 64-bit versions of the following operating systems:

- Microsoft® Windows® 7
- Microsoft® Windows® 8.1

Additional software recommendations include Microsoft® Internet Explorer® 11 web browser (minimum), Microsoft® Office 2010 or 2013, and Adobe® Acrobat Reader DC (for optimal viewing of the Documentation Portfolio and release notes).
2 Preliminary Setup

The ParticleTrack instrument should already be set up as described in the specific hardware manual installation chapter. Before installing software, disconnect the instrument from the control PC. After software installation, reconnect the instrument.

NOTE: If your instrument was shipped prior to September 2013, you must have the ACIO Smart Chip upgrade completed on your hardware to use iC FBRM 4.4. If you’re unsure whether your instrument has been upgraded, please contact AutoChem Support Group.

2.1 Configure PC Power Settings

On the PC that will be controlling an instrument, you must adjust the power settings to ensure the computer will never go into sleep mode.

1. Search ‘Power Options,’ and select ‘High Performance.’
2. Select Change plan settings link.
3. Set ‘Put the computer to sleep’ to Never.
4. Select Change advanced power settings link and set as follows:
   - Sleep → Sleep after = Never
   - Sleep → Hibernate after = Never
   - USB Settings → USB selective suspend setting = ‘Disabled’
   - For laptop computers: Power button and lid options → Lid Close Action = ‘Do nothing’
5. Click OK and Save changes.

2.2 Disable User Account Control Notifications

Adjust the computer settings under User Account to enable the FBRM instrument to communicate freely with the software. To take effect, this change requires a reboot of the control computer.

2. Move the slider to **Never Notify** and click **OK**.
3 Installing iC FBRM 4.4 Software

iC FBRM™ installation is wizard-driven. When you start the process from the installation welcome page (Figure 1 on page 7), the wizard guides you through the steps to install the iC FBRM software and ParticleTrack instrument drivers, starting with prerequisite Microsoft® Windows® components, as applicable.

**NOTE:** The wizards and windows shown in this guide are from a Microsoft® Windows® 7 installation. Corresponding wizards and windows displayed for Microsoft® Windows® 8 will differ slightly in appearance, but the functionality is the same for each operating system.

In addition to the installation process, this guide also includes information on setting software preferences, activating licenses, and setting up instrument interoperability between iC and iControl software applications.

**Important:** ParticleTrack instrument should be unplugged from the PC during software installation.

### 3.1 Necessary User Rights

**NOTE:** Installation requires Administrative privileges. If the user account is not part of the Admin group on the local PC, right-click setup.exe and select “Run as administrator.”

To run iC FBRM, normal user privileges are sufficient.

iC FBRM 4.4 can be installed next to previous versions of iC FBRM, but they cannot be run at the same time.

### 3.2 Starting iC FBRM Installation

Follow the steps below to install iC FBRM 4.4 on a PC that meets the minimum system requirements described on page 4.

1. Insert the installation CD or go to the downloaded installation folder.

   If you inserted the CD, the following welcome window appears:

   ![Installation welcome window](Figure 1: Installation welcome window)
If the welcome window does not appear or if you have downloaded the installation folder, open the CD or folder.
Then, click autorun.exe to display the welcome window.

2. In the welcome window, click Install iC FBRM 4.4 (setup.exe).

3. Click Install at the prompt to install the FBRM Server.

4. Read and accept the license agreement to install the Microsoft® .NET framework required component.

**NOTE:** This step only applies if the Microsoft® .NET required component does not already exist on the computer where you are installing iC FBRM.
5. When the iC FBRM installation wizard appears, click **Next**.

6. Click **Next** to move through the installation wizard steps.

   **NOTE:** If installing a service pack, you may not see all the installation wizard steps described in this section.

7. If you have an ‘Office’ version of iC FBRM, meaning it will not be connected to an instrument, click **No** in the Select Instrument window. Proceed to step 10.
   If you have an ‘Instrument’ version of iC FBRM, meaning this computer will be connected to an instrument, click **Yes** to install drivers and proceed to the next step.

8. Select Instruments for which Drivers will be installed and specify the Default Instrument.
   a. Select the instrument types that will be used on this PC. The selection determines the drivers that will be installed.
   b. If you selected multiple instrument drivers to be installed, choose the Default Instrument type that will be connected to this PC.

9. Click **OK**.
   Instrument driver installation begins.

   **NOTE:** This phase of installation could take several minutes.

10. Click **Close** after successful completion.

11. Reboot the control PC (instrument is still NOT connected).
3.3 Plug the ParticleTrack Instrument into the Computer

Connect the instrument USB cable to a USB port on the control computer. Please refer to individual hardware manual for connection details as ParticleTrack G600 and E25 instruments include a Fiber-to-USB Extender. Depending on the instrument type, the connection will be different:

- ParticleTrack G600/G600Ex and E25—USB (via Fiber-to-USB extender between base unit and PC)
- ParticleTrack G400—USB

3.4 Start iC FBRM Software

1. Start the iC FBRM software application by clicking the desktop icon or selecting iC FBRM 4.4 from the METTLER TOLEDO program menu in the Start menu.

2. A message appears indicating the software is running on a trial license:

   ![Trial Version Screen]

   o If you have a License Key, click **Activate Now** to proceed with the registration process. Instructions begin under iC Licensing on page 12.
   o If you prefer to remain on the 30-day trial license, click **Activate Later**.

   **NOTE:** The 30-day trial provides access to all iC FBRM 4.4 features.

3.5 Scanning for Instrument

The first time you connect a ParticleTrack instrument to the iC FBRM control software, the control computer needs to scan to establish the USB connection.

1. From the File menu > Tools menu, select **Instrument Connections**.

2. In the Instrument Connections window, click **Edit** to scan for the instrument, and click **OK** when the automatic configuration message appears.
4 Checking for Updates

If you already have a release of iC FBRM installed and want to see if you have the latest service pack, select “Check for Updates” from the Help menu.

After login to the AutoChem Community website, you will see a message that indicates whether or not you are running the latest software. The next section describes how to apply a service pack.

4.1 Applying an iC FBRM 4.4 Service Pack

**NOTES:** Updating to a new service pack retains the 4.4 license.

> Updating to a new service pack requires updating the iC FBRM application and the FBRM server by running two service pack installers.
>
> Installing the server is only necessary on the computer that controls the instrument (Instrument software license). When installing both service packs, install the FBRM server first.

If you already have a release of iC FBRM 4.4 installed and want to apply the latest iC FBRM 4.4 service pack, run the service pack installers, as follows.

1. Download the service pack installers for iC FBRM and for FBRM Server. Then, follow the instructions provided to extract the contents. (Options for accessing the service pack installers are in the next section.)
2. Locate the .msi files for the server software in the extracted contents: `FBRMServerSetup.msi` and `iCFBRM_Installer.msi`
3. First, run the .msi file for the FBRM server to launch the installation wizard and follow the prompts to install the service pack. Then, run the `iCFBRM_Installer.msi` for the iC FBRM software.

4.2 Accessing the Service Pack Installers

The service pack installers are available from the AutoChem Community website. You can use either of the following methods to access a service pack from the Downloads page:

- **Through iC FBRM software—Check for Updates:**
  iC FBRM Help menu ➔ Check for Updates
  Log in to the AutoChem Community website. This method informs you whether you are using the latest release and service pack. If a service pack or new release is available, use the link to the Downloads page to access the installer.

- **From the METTLER TOLEDO AutoChem Community Website:**
  Go to [https://community.autochem.mt.com](https://community.autochem.mt.com)
  Log in and select iC FBRM from the Downloads menu. Check the Service Packs section to see if any service packs exist for your version of the software.
5 iC Licensing

iC applications use a licensing scheme to control distribution and use of the software. Below are the types of licenses.

- **Instrument version**—Enables the application to connect to an instrument and run experiments.
- **Office version**—Enables the user to run the application without a connection to an instrument. With this version, experiment data can be viewed and analyzed.
- **Trial version**—A trial version is equivalent to an Instrument license with a 30-day time limit.
- **Module licenses**—Add-on modules, licensed separately.
  - **Chord Selection Model (CSM) licenses**—ParticleTrack instruments require a valid license for the CSMs that convert raw FBRM signal data into chord length distributions.
- **iCare subscription**—A special annual subscription license that entitles you to all release upgrades and service packs for instrument and Office versions of your iC and iControl software as well as priority telephone and email support. Please refer to Activating an iCare Subscription on page 16.
- **Site license**—Specific companies that have large software agreements with METTLER TOLEDO may also have a Site License for a particular product or products. Please refer to Installing a Site License on page 18.

5.1 Activating a Single-User License

**NOTE:** Although you need to activate your software on a website, the PC where you are installing the iC FBRM software does not require an internet connection. You can activate the software license using any internet-enabled PC.

The following information applies to users installing a single-user Instrument, Office, or CSM module license. The first time the iC application starts, the system displays the Trial License message. Choose to activate the license now or later.

Select one of the following two options:

5.1.1 Activate Later—Continue Under a 30-Day Trial License

Click **Activate Later** in the Trial Version window to defer license activation. You can activate the license at any time by selecting License Manager from the iC FBRM software Help menu. A reminder link appears on the iC FBRM Start Page to keep you informed of the trial period.

5.1.2 Activate Now—Using the License Manager

When you click **Activate Now**, the License Manager window opens. The License Manager contains an 8-character Machine ID and an area to input a 25-character Activation Code field.
in 5-character segments. Follow the steps below to obtain the code from the AutoChem Customer Community website. The process starts in the License Manager and links to the AutoChem website to obtain an activation code. Then, you return to the License Manager.

**NOTE:** If you purchased iCare at the same time as iC FBRM 4.4, activate your 4.4 license first. Then, follow the steps on page 16 to activate the iCare subscription.

1. Have your License Key sheet ready. The sheet is usually a letter-sized certificate delivered with the software.
2. In the License Manager window (Figure 2), click **Copy** after step 1 to copy the machine ID to your clipboard.
3. Click the link (https://community.autochem.mt.com) after step 2.
4. Obtain your Activation Code from the AutoChem Community website by following the instructions in the next section entitled: “Obtaining an Activation Code from the MT Website.” The Machine ID that you copied to the clipboard will be used, along with your License Key, to generate an activation code.

Once you have copied the activation code from the AutoChem Community website (see page 15), return to the License Manager and complete the following two steps:

5. In the License Manager window, click **Paste**. The activation code from your clipboard appears in the text boxes.
6. Click **Apply Activation Code** to complete the registration process.
7. Repeat the process to activate one or more Chord Selection Models (CSMs) that determine the type of algorithm used to characterize a particle or droplet system. Speak with your Technology and Applications Consultant (TAC) to determine the proper CSMs for particular particle systems.

### 5.2 Obtaining an Activation Code from the MT Website

Your activation code is generated through the METTLER TOLEDO AutoChem Community website (https://community.autochem.mt.com). To obtain the activation code, you must have the Machine
ID from the License Manager window in the iC software and the License Key provided on a letter-size certificate with the software. (Refer to the previous section on Using the License Manager to Activate a Single-User License.)

**NOTE:** Access the MT website from any internet-enabled PC—This step does not necessarily need to be performed on the PC where the iC FBRM software is installed.

1. Depending on whether or not you have an account, start with one of the following steps:
   - If you are a new user, begin by setting up a user account (see page 16).
   - If you already have an account, enter your username and password and click **Log in** under User login or click **log in** from the red prompt box.

2. Enter the required information and click **Log in**.
3. Click **Activate an iC or iControl License** from the My Account tab.

![Activate License](image)

4. Enter the Machine ID and License Key or use the **Paste** buttons (highlighted below).

**NOTE**: The Paste and Copy buttons only apply to Microsoft Internet Explorer. In any other browser, you must enter the information.

The Machine ID can be copied from the License Manager window. The License Key is provided on a license certificate sheet delivered with your software.

![Activate License Window](image)

5. Click **Generate Activation Code** to produce the code in the text box. Then, click **Copy** to save the code to the clipboard.

6. Return to the License Manager in the iC FBRM software (see page 12), and click **Paste** to enter the activation code in step 3. **Enter Activation Code**.

![Activation Code](image)

7. Click **Apply Activation Code** to complete the registration.
8. Repeat the process to install any module licenses on the PC, such as a Chord Selection Model.

5.3 Setting Up a New User Account

If you do not already have a user account on the METTLER TOLEDO AutoChem Community website, you will need to create one before your licenses can be activated.

1. From the METTLER TOLEDO AutoChem Community website, click the Create new account link.
2. Enter the required information and accept the terms.
3. Click Create new account at the bottom of the registration form.

The AutoChem Customer Community website confirms that an email is being sent:

Your password and further instructions have been sent to your e-mail address.

You will receive an email with instructions and a link to confirm your email address and complete the new account registration.

NOTE: Your website registration will be pending until confirmed by METTLER TOLEDO AutoChem; however, you can activate the software by following the link provided in the email.

4. Click the first link to confirm your email. You will go to a one-time login where you create a password.
5. After you change and confirm the password, click Save at the bottom of the page.
6. From the Home page, select Activate an iC or iControl License under the My Account tab.
7. Follow the instructions under Obtaining an Activation Code from the MT Website on page 13.

5.4 Activating an iCare Subscription

The procedure to activate an iCare subscription is similar to that for obtaining an activation code from the MT website for a single-user license. The 12-character iCare Subscription Number will be provided on an iCare Subscription Certificate that shipped with your order.

1. Login to the METTLER TOLEDO AutoChem Community website.
2. Click Activate an iCare Subscription from the My Account tab.
An Activation iC License or iCare Subscription window appears with the iCare Subscription selected.

3. In the iCare activation window (Figure 4), enter the Machine ID as directed in the Note, or use the Paste button (highlighted below). The Machine ID can be copied from the License Manager window.

![Figure 4: Activate an iCare Subscription window](image)

4. Enter or paste the Subscription Number, provided on a certificate sheet delivered with your software.

5. Click the Activate Subscription button. You should receive a confirmation email message in a few minutes that provides some additional information about the program.

6. The email will also include an iCare Subscription Activation Code that can be entered or pasted back into the License Manager window of the iC FBRM software.

Activating the iCare subscription in the software itself is not required, but if you perform this step, then you will not need to update any licensing information if a new iC FBRM version is released before the iCare subscription expires.
5.5 Installing a Site License

**NOTE:** Most companies do NOT have a site license, so only follow this procedure if specifically directed by your organization.

A Site License is supplied as a file and must be loaded into each copy of the iC software in use. (Please refer to iC Licensing on page 12 for an explanation of site licenses.)

1. To install the Site License, open the License Manager by selecting it from the Help menu.

2. In the License Manager, click **Enable**.

3. Click **Browse** to navigate to the Site License file location. Then, click **OK**.

The license loads and the software is ready to use.

4. Repeat on the other computers with iC FBRM installed.
6 Sharing Data between iC/iControl Applications

Data can be shared between iC and iControl applications. The three common situations are:

- iC and iControl applications are on the same PC
- iC and iControl applications are on different PCs on the same network
- iC and iControl applications are on different PCs connected via an Ethernet cross-over cable

6.1 Before You Begin

a. Ensure that the iC and iControl applications are installed and operating properly on each PC.

b. Verify the release versions of the products are compatible by checking the Compatibility Table: DotNet Version Compatibilities for iC/iControl Data Sharing on the AutoChem Customer Community website (link to Compatibility Table page).

c. Ensure the latest service pack for each product is installed (see Checking for Updates on page 11 for details).

**NOTE:** Any PCs that will be coordinating live experiments should have the same regional settings and be in the same time zone.

6.2 Connecting iC/iControl Applications

Below are the steps to get the iC/iControl applications to connect.

a. Start the iC or iControl application on each PC.

b. To establish a link, iC 4.x versions of software must broadcast their existence.

  - For iC 4.x applications—Go to the main Tools menu and select **Connect to other iC/iControl applications**…

1) Click the **Find Application** button on each PC, if applicable, to begin a network scan for the other applications. Repeat for all applications to be connected.
2) Once this initial scan is performed the Application Type list displays all iC /iControl applications currently running the Find Application process on the network. On each PC, the corresponding applications should appear on the list and the Status column should show Connected.

**NOTE:** If an application connection cannot be made, the Application Type column entry is “Unknown.” Please refer to Configuring the Windows Firewall on page 22.

- For iControl—Select Configure Equipment from the Start Page. (NOTE: The configuration below features iControl 5.4.)

1) Click **Add Instrument** and then, select the new device of the appropriate type, for example, iC FBRM.

2) Click OK in the Insert iC FBRM prompt.
3) In the Settings section, select the applicable configuration:
   - Accept the default if iC FBRM and iControl are installed on the same PC, or
   - Enter the PC Name or IP address of the PC where iC FBRM is installed.

4) Click Test Connection to verify the settings, and then Save the configuration.

   There is no need to rescan the network PCs in the future unless a new iC/iControl application or PC running an application is added to the network. In this case, a scan must be run on all PCs to update the Application Type list.

   Once communications between the iC/iControl applications has been established, trend data for the applications display in the Result List Add Trends list.

   **NOTE:** There is no corresponding test in iC—Use the checks below for testing.

   c. To verify that the connection is working for all aspects of the software application, perform the following checks:

      **iControl-to-iC connection**

      1) In iControl, start a new experiment and include the iC device in the equipment setup.
      2) Execute the run and verify that you can start a new iC experiment from the iControl wizard.
      3) Verify that the iC experiment starts when the iControl experiment starts.
      4) Check that the iC operations can be used in the iControl procedure (for example: Change Sample Interval, Pause, etc.).
      5) Add iC trends to the iControl Trend Viewer.
      6) Try another iControl experiment that specifies a template file for the iC FBRM experiment that iControl will start. When starting an iC experiment from the iControl experiment Start wizard, the template should be automatically selected for the iC experiment.
iC-to-iC connection
1) Add trends from an open experiment in one application to the other iC application’s live or completed experiment.
2) Verify that live trends from one iC application are correctly updated in a live experiment in the other iC application.

iC-to-iControl connection
1) Add iControl trends to the iC Trend Viewer.
2) Verify that live trends from iControl are correctly updated in a live iC experiment.

If you have trouble getting the applications to talk, then you can execute the procedure described next under Configuring the Windows Firewall.

6.3 Configuring the Windows Firewall

The instructions in this section are only required if the iC software applications are on different computers and the initial connection setup did not work.

1. On the PC running the iC FBRM application, click the Start → Control Panel → System and Security → Windows Firewall (or use the start search option for firewall.cpl).
2. Select the Allow a program option.
3. Select the **Allow another program** button (if this button is not enabled, click the **Change Settings** button).

![Firewall Settings](image)

4. Select the **Browse** option and locate:
   
   C:\Program Files (x86)\METTLER TOLEDO\iC FBRM 4.4\iCFBRM.exe

**NOTE:** If you install a different version of iC FBRM, you will need to repeat this process for the new version.

5. Repeat the above process for C:\Program Files (x86)\METTLER TOLEDO\FBRM Server 4.4\FBRMServer.exe

6. On the PC running the other iC software, repeat steps 1–4 and add an exception to the firewall for appropriate programs such as:
   - C:\Program Files (x86)\METTLER TOLEDO\iControl 5.4\iControl.exe AND C:\Program Files (x86)\METTLER TOLEDO\iControl 5.4\iControlServer.exe
   - C:\Program Files (x86)\METTLER TOLEDO\iC IR 4.3\iCIR.exe
   - C:\Program Files (x86)\METTLER TOLEDO\iC PVM 7.0\iCPVM.exe
   - C:\Program Files (x86)\Kaiser\iC Raman 4.1\iCRaman.exe
### 6.4 Turning Off TCP/IPv6 Protocol

If there are still communications issues (either failures to connect or long waits for connections) between iC FBRM and the other iC or iControl computer, another suggestion to try is to disable the IPv6 protocol on the network adapter used to connect to the other computer. IPv6 is the new computer address protocol that will eventually replace IPv4 which is currently the most popular standard. The iC applications use IPv4 to communicate but if IPv6 is enabled, it is usually tried first before IPv4 and this can cause delays in connections or timeout errors. Unless your network has a specific requirement for IPv6, and very few do, you can safely disable IPv6.

1. On the PC running iC FBRM, click the **Start → Control Panel → Network and Sharing Center**.
2. In the 'View your active networks' area, click **Local Area Connection**.

![Image of Network and Sharing Center settings](image)

3. Click **Properties** and, on the Networking tab, uncheck the Internet Protocol Version 6 (TCP/IPv6) check box, and click **OK**.

![Image of Local Area Connection Properties](image)

If you have issues connecting to other iC/iControl applications, please send an email to [iC@mt.com](mailto:iC@mt.com) for assistance.
7 Appendices

7.1 Installing iC FBRM Office via Scripting

iC FBRM installation options include the following argument syntax that enables IT personnel to silently install iC PVM Office licenses using your organization’s scripting tool.

1. Note the folder location path and filename for the `data.msi` file.

2. If applicable, note the server name where iC Data Center (`icdcserver`) resides and ensure the server is running.

3. Use the following argument syntax:

   ```
   msiexec /i "<folder path>\Data.msi" /qn quiet=true InstallDir=<install path> icdcserver=<server name>
   ```

   Example:
   ```
   msiexec /i "C:\Installer\data.msi" /qn quiet=true InstallDir=C:\ABC icdcserver=abc10-svr2
   ```

   **NOTE:** If a path includes spaces, the entire name must be surrounded by double quotation marks.

4. Complete the installation wizard. Verify the wizard shows the install path specified in silent command.

   **NOTE:** When silently installing upgrades, ensure the `InstallDir=<install path>` is the same as that used in the previous installation.

7.2 Deployment Packages and Dependencies

The iC software installation program runs scripts that deploy packages as part of the installation process. Packages deployed by the installer include items such as device drivers, product licensing, and documentation. Dependencies include third-party prerequisites such as the Microsoft .NET framework. Specific versions of each package and dependency are included, where applicable (shown in tables on page 25).

<table>
<thead>
<tr>
<th>iC Software Deployments</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client software deployed to <code>C:\Program Files (x86)\METTLER TOLEDO\iC FBRM 4.4</code></td>
<td>Installation path</td>
</tr>
<tr>
<td>Server deployed to <code>C:\Program Files (x86)\METTLER TOLEDO\FBRM Server 4.4</code></td>
<td></td>
</tr>
</tbody>
</table>

Deployed with software:
- Chord Selection Models (CSMs)
- iC FBRM Documentation Portfolio (PDF)
- iC FBRM Release Notes and Installation Guide (PDFs)

Miscellaneous configuration files deployed to: `C:\ProgramData\METTLER TOLEDO\iC FBRM\4.4`

<table>
<thead>
<tr>
<th>Third-Party Dependencies</th>
<th>Version</th>
<th>Notes</th>
<th>Third-Party</th>
</tr>
</thead>
<tbody>
<tr>
<td>.Net Framework</td>
<td>4.0</td>
<td></td>
<td>Microsoft® Corporation</td>
</tr>
<tr>
<td>Windows installer</td>
<td>3.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SyncFusion, DevExpress, ChartFX, PlexityHide.GTP</td>
<td>Refer to Help &gt; About &gt; <strong>Component Info</strong> for details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device drivers and interface DLLs (based on type of instrument selected)</td>
<td>various</td>
<td></td>
<td>Pico Technologies</td>
</tr>
</tbody>
</table>
Learn More with our
Technical Webinar Program

Our on-demand webinars (online seminars) provide application
and industry information relevant to you. These interactive presentations,
provided by industry experts and our own applications team, give you an
opportunity to learn more about your specific area of interest.

Topics include:
- Improving Crystallization and Precipitation Processes
- The Importance of Mixing in Process Development
- Avoiding Incidents During Scale-up
- Recent Advances in Organic Chemistry
- Calorimetry Best Practices
- Characterization of Catalytic Hydrogenations
- Plus other applications including green chemistry, organic synthesis,
  fermentation, high pressure chemistry and more

www.mt.com/ac-webinars